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Introduction

OpenTextTM Active Catalogue is the leading product information database for the 
electronic exchange of product information between retailers and vendors in the 
GM&A, grocery, hardlines, and other industries worldwide. It contains more than 
220 million Global Trade Item Numbers (GTINs) from over 7,000 vendors and 
grows daily.
OpenText Active Catalogue enables vendors to focus on product catalogue content 
and sales instead of storing and communicating product information in different 
formats for different customers.
The chapter is organized as follows: 
■ “About This Guide.”
■ “Audience” on page 2.
■ “Conventions Used in This Guide” on page 2.
■ “Accessing Product Documentation” on page 2.
■ “Contacting Technical Support” on page 3.

About This Guide
This guide explains how to create a comma separated values (CSV) text file to 
upload small volumes of catalogue item or image data. It serves as a reference for 
the structure and rules that govern a properly formatted comma separated values 
(CSV) text file. Examples show how to use Excel as a tool for working with a text 
file. 
The guide is organized as follows: 
■ Chapter 1, "Overview," on page 4 is a general explanation of how and when to 

use CSV text files to upload and download data in Catalogue.
■ Chapter 2, "Creating a CSV Text File to Upload Data," on page 5 describes in 

detail how to create a CSV text file and upload small volumes of catalogue item 
or image data using a comma separated values (CSV) text file

■ Chapter 3, "Opening a Downloaded CSV Text File in MS Excel," on page 16 
steps you through the process of setting options in MS Excel so that GTIN, 
Selection Code, and Product data is preserved.
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Audience
This guide is intended for vendors who want to use a CSV text file from an existing 
application and use it to upload data to OpenText Active Catalogue using the 
browser interface. This guide assumes a high level of understanding of desktop 
applications and the ability to work with text file formats. It is a reference guide for 
the structure and rules that govern a properly formatted Catalogue CSV text file.

Conventions Used in This Guide
This guide uses the following conventions:

This convention... Indicates... Example...

Bold text Button, or field names, 
menu options, and 
hyperlinks

Save

“Text in quotes” Cross-reference to a 
section of the guide

“Accessing Product 
Documentation” on 
page 2

Accessing Product Documentation
You can access all of the OpenText product documentation for OpenText Active 
Catalogue from within the Catalogue application. Most documentation is delivered 
in Adobe Acrobat PDF format. To read and print the documents, you will need 
Adobe Acrobat Reader, a free product from Adobe Systems. For information about 
downloading and installing Acrobat Reader, see the section, “Installing Adobe 
Reader.”

To access the product documentation
1 Log in to OpenText Active Catalogue.
2 Click Product Documentation > All Documents.

The Product Documentation List page opens. A list of the documents is 
displayed.

3 You have the option to open the document or save it to your computer. Do one 
of the following:

■ To open a document, click the document link. The document opens in a 
separate window.

■ To save the document to your computer, right click the document link and 
select Save Target As. The Save As window opens. Navigate to the 
location where you want to save the document, and click Save. The 
document is saved to your computer.
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Contacting Technical Support

Installing Adobe Reader
Since most OpenText product documentation is delivered in Adobe Acrobat PDF 
format, you will need Adobe Reader to read and print the documentation. Adobe 
Reader is a free product from Adobe Systems. 

To download and install Adobe Reader
1 Launch a Web browser and navigate to http://get.adobe.com/reader
2 Download and install Adobe Reader. Follow the screens, accepting the defaults.

You can now access OpenText product documentation by double-clicking the PDF 
file.

Contacting Technical Support
To contact OpenText Cloud Support Services (CSS) for assistance in North America:
■ Email cataloguesupport@opentext.com

■ Call 800-334-2255
To contact OpenText Cloud Support Services (CSS) for assistance in Europe, refer 
to the OpenText website at http://www.opentext.com for available phone numbers

mailto:cataloguesupport@opentext.com
http://get.adobe.com/reader
http://www.opentext.com
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Overview 1
This guide explains how to create a comma separated values (CSV) text file to 
upload small volumes of catalogue item or image data to OpenText Active 
Catalogue. 

Uploading Data
Text File Upload is a way to upload small volumes of catalogue data using a text 
file. It is useful for vendors with smaller catalogues who may have too many items 
to enter using the browser user interface (UI), but too few items to need the 
scalability of EDI or Web Services. 
To take advantage of Text File Upload using the browser interface, you need to 
prepare a comma separated values (CSV) text file in a format acceptable for 
uploading to OpenText Active Catalogue. CSV text files can be created from many 
common desktop applications including Microsoft Excel (MS Excel) and Microsoft 
Access (MS Access). 

Downloading Data
When you download data from OpenText Active Catalogue, Catalogue creates a 
text file. You can open the text file in MS Excel and set specific options that 
preserve the format of the GTIN, Selection codes, and Products. We recommend 
this method if you want to make changes to the file and upload data back into 
Catalogue.



 5

Creating a CSV Text File to 
Upload Data 2

This chapter explains how to create a comma separated values (CSV) text file and 
use it to upload small volumes of catalogue item or image data.
Topics include:
■ “Using Text File Upload” on page 5
■ “Using a Downloaded Text File for a Text File Upload” on page 6
■ “CSV Text File Format Rules for Catalogue” on page 6
■ “Creating a CSV Text File from an MS Excel Spreadsheet” on page 10
■ “Using a CSV Text File to Upload Data” on page 13
■ “Correcting Errors in the CSV File” on page 15

Using Text File Upload
Text file upload is a way to upload small amounts of Catalogue data using a CSV 
text file. For CSV text file upload, the following topics are relevant.

If you want to... Use the following option: See this topic:
Use a text file download file as a text 
file upload file

Not applicable “Using a Downloaded Text File for 
a Text File Upload” on page 6

Review the guidelines for formatting a 
CSV text file.

Not applicable “CSV Text File Format Rules for 
Catalogue” on page 6.

Create a CSV text file for the products 
or items you want to upload.

MS Excel or similar application “Creating a CSV Text File from an 
MS Excel Spreadsheet” on page 10

Upload small volumes of catalogue 
item or image data using a CSV text 
file

Data Management > Text File Upload “Using a CSV Text File to Upload 
Data” on page 13

View a CSV text file using Notepad Not applicable “Viewing the CSV Text File in 
Notepad” on page 13

Correct Errors in a CSV text file Data Management > Text File Upload “Correcting Errors in the CSV File” 
on page 15

Open a Downloaded CSV text file in 
MS Excel

Not applicable Chapter 3, “Opening a 
Downloaded CSV Text File in MS 
Excel.”
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Using a Downloaded Text File for a Text File Upload
You can use a text file previously downloaded from Catalogue (TFD file) as the 
basis for a text file upload (TFU). 
There are two things to keep in mind:
■ The TFD file does not include an action column. 

To use the TFD file as a TFU file, you need to add a column to the CSV text file 
that specifies the action you want to perform on each GTIN in the file (insert, 
update, replace, or delete).

■ In the header row of the CSV text file, as the first entry, add the word 
action. 

■ In every subsequent row of data, specify the action you want to perform 
on that row’s GTIN data (insert, update, replace, or delete)

You can add the column and corresponding information in the CSV text file or in 
the Excel file (before you save it as a CSV text file). Then upload the CSV text 
file using the UI.
For more information about creating a properly formatted CSV text file, see:

■ “CSV Text File Format Rules for Catalogue” on page 6.
■ “Creating a CSV Text File from an MS Excel Spreadsheet” on page 10.

■ The TFD file includes three columns that will not be used when the file is used as 
a TFU file. The following three columns are ignored:

■ VENDORACCOUNT
■ CREATE_DATE
■ UPDATE_DATE

CSV Text File Format Rules for Catalogue
Understanding the format rules described below will enable you to produce an 
acceptable file you can upload toCatalogue using the browser interface. 
Once you understand the rules, you can use one of many applications including MS 
Excel and MS Access to create an acceptable CSV text file. 

Basics
The OpenText Active Catalogue CSV text file is self-describing data file. The first 
non-blank row is the header row and defines the attribute names and the order 
that they will appear throughout the rest of the file. The remaining non-blank rows 
contain the item data with one item per line, with attribute values appearing in the 
order defined in the header row.

Structure
The following sections describe the structure of the CSV text file.
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CSV Text File Format Rules for Catalogue

Character Conventions
The CSV text file uses one line for each item of data. The lines can be separated by 
either line feed (ASCII 10) characters or a pair of carriage return (ASCII 13) and 
line feed characters. 
The CSV text file separates fields on a line with a comma character. If a field value 
needs to contain a comma character, the whole field must be surrounded by 
double quotes (ASCII 34). 
If a field needs to contain a quote character, it must be proceeded by an additional 
quote character.

Required Attributes
Every CSV text file must include (at the minimum) the following fields:
■ SELCODE
■ PRODUCT
■ ITEM_NUMBER
■ ITEM_NUMBER_TYPE
These attributes identify the Catalogue item that will be changed. The following 
example is a simple file that inserts this item into the Catalogue:
ACTION,SELCODE,PRODUCT,ITEM_NUMBER,ITEM_NUMBER_TYPE,ITEM.DESCRIPTION
Insert,001,PID001,123412341551,UP,Item Description

Blank Rows
Catalogue ignores blank rows (all white space and no delimiters) in the CSV text 
file; however, blank rows are reflected in the line numbers used to report errors 
(they are counted as a row). In the example below, rows 1, 3, and 5 are blank 
rows. Rows 2, 4, and 6 are data rows. Row 2 is shown wrapping.

row 1
row 2 ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,

ITEM.DESCRIPTION,ITEM.ORIGIN_COUNTRY,ITEM.ORIGIN_COUNTRY
row 3
row 4 123456789012,UP,JEANS,DESIGNER BLUE,USA,MEX
row 5
row 6 123456789012,UP,JEANS,DESIGNER BLUE,USA,CAN

File Size
The CSV file can have a maximum number of 1000 data rows (blank rows are not 
counted).

Header Row

Header Fields
The first non-blank row is the header row. The fields in the header row are Active 
Catalogue attribute names. These names are case-insensitive and are in one of the 
following formats:
■ The attribute name listed in the OpenText Active Catalogue Attributes Guide (for 

example, ITEM.COLOR_DESCRIPTION or ITEM.NRF_SIZE_CODE). 
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■ The attribute name displayed on the Edit GTIN Details screen in the OpenText 
Active Catalogue application (for example, Color Description or NRF Size Code, 
as shown below)

Use the attribute name up to, but not including, the first comma that is displayed. 
Include parentheses when it is part of the name. See the examples in the following 
table.

Attribute Name Displayed on 
Edit GTIN Details Screen

Attribute Name Used in 
CSV Text File

Booking Date (Item Effective Date) Booking Date (Item Effective Date) 
Dangerous Goods Item, Y/N: Dangerous Goods Item

 

Qualifying an Attribute Value
When an attribute requires a qualifier (either a UOM or Private Account ID), the 
field immediately following the attribute must contain the qualifier. The qualifier is 
identified as a colon followed by the qualifier (UOM or Private_Account_id). 

U O M  E x a m p l e
In the CSV fragment below (the ellipses indicate that only part of the CSV text file 
is shown), Consumer Package Length has a UOM of inches (IN) and Consumer 
Package Gross Weight has a UOM of ounces (OZ).
...Consumer Package Length,:uom,Consumer Package Width,:uom,Consumer Package 
Height,:uom,Consumer Package Gross Weight,:uom,Consumer Package Volume (Cube),:uom
...10,IN,5,IN,2,IN,16,OZ,1.3,CF

P r i v a t e  A c c o u n t  I D  E x a m p l e
In the CSV fragment below, Unit Cost is an attribute that has a UOM qualifier of 
U.S. dollars (USD) as well as a Private Account ID qualifier of 123456789012. 
These qualifiers are followed by fields for the Unit Cost Effective Date and Unit Cost 
Expiration Date which are associated with the private cost values. 
...Unit Cost,:uom,:Private_Account_id,Unit Cost Effective Date,Unit Cost Expiration Date
...80,USD,1234567890,1/1/2005,1/1/2006

Optionally, to clearly identify the attribute that is being qualified, you can repeat 
the name of the attribute before the colon of the qualifier, as shown in the CSV 
fragment below:
...Unit Cost,Unit Cost:uom,Unit Cost:Private_Account_id,Unit Cost Effective Date,Unit Cost Expiration 
Date
...80,USD,1234567890,1/1/2005,1/1/2006



9 OpenText Active Catalogue Text File Reference Guide

C R E A T I N G  A  C S V  T E X T  F I L E  T O  U P L O A D  D A T A

CSV Text File Format Rules for Catalogue

Multiline Attributes
For each row in the CSV text file, multi-line attributes must appear as consecutive 
fields. In the following example, ITEM.ORIGIN_COUNTRY is the multi-line attribute 
and appears twice, one field next to the other.
ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,ITEM.DESCRIPTION,ITEM.ORIGIN_COUN
TRY,ITEM.ORIGIN_COUNTRY
123456789012,UP,JEANS,DESIGNER BLUE,USA,MEX
123456789012,UP,JEANS,DESIGNER BLUE,USA,CAN

Data Rows

Missing Values
A data row contains values for the fields defined in the header row. If an item does 
not have a value for the corresponding field, it can be left blank. This should 
appear in the CSV text file as a repeated delimiter. Trailing commas are needed for 
missing values at the end of a row.
Note: Since empty fields are allowed, it is not possible to remove a specific 
attribute value from an item using the update action. Use the replace action to 
remove attributes values.
For example, the following CSV text file does not have a value for the first 
ITEM.ORIGIN_COUNTRY field. The missing value is accounted for by the repeating 
commas.
ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,ITEM.DESCRIPTION,
ITEM.ORIGIN_COUNTRY,ITEM.ORIGIN_COUNTRY
123456789012,UP,JEANS,DESIGNER BLUE,,MEX

Quoted Values
If a value needs to contain the delimiter character (for example: DESIGNER, 
BLUE), the corresponding field in the CSV text file needs to be surrounded by 
double quotes ("DESIGNER, BLUE"). If the value contains a quote character, the 
quote character must be proceeded by another quote character. 
For example, DESIGNER, "BLUE" needs to appear in the CSV text file as 
"DESIGNER, ""BLUE""".
ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,ITEM.DESCRIPTION,ITEM.ORIGIN_COUN
TRY,ITEM.ORIGIN_COUNTRY
123456789012,UP,JEANS,"DESIGNER, ""BLUE""",,MEX

Excess Data Values
A data row cannot contain more data values than you have defined in the header 
row. If it does, the line will generate an error and be ignored.

Action Field
You can use a field to specify the action of a row (insert, update, replace, or 
delete). The following rules apply:
■ If you use a field to specify an action, and you specify insert for an existing item, 

the system will generate an error. 
■ If you use a field to specify an action, and you specify update or replace for an 

non-existent item, the system will generate an error. 
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■ If you do not use a field to specify an action, the system uses the appropriate 
action to load the data into Catalogue (it inserts an item if there is no existing 
item and updates an item if it already exists).

■ If you specify replace for an existing item, the item is updated only with the 
attributes specified in that data row. Attributes for the item that are omitted from 
the data row are removed from the existing item. The item has a new delta time 
stamp but its create time stamp is preserved. All of the item attributes have a 
new delta time stamp. 

■ Selection Codes and Products can be created via text file upload. Selection Code 
description, Product description, and Product extended description can be 
updated or replaced via text file upload.

■ Text file upload supports implied Product delete; that is, if you use a CSV text file 
to delete the last item in a Product, the Product will be deleted.

Hierarchy Creation
Catalogue will automatically create a Selection Code/Product hierarchy from the 
values provided in the CSV text file as long as all the necessary values are present. 
For Catalogue to create the hierarchy, the CSV text file must contain values for the 
Selection Code (selcode), Selection Code description (hierarchy.node_description), 
Product (product), and Product description (hierarchy.product_description). 

Creating a CSV Text File from an MS Excel Spreadsheet
The steps in the following table describe how to create a CSV text file from an MS 
Excel spreadsheet.
Your CSV text file must conform to the CSV format specifications described in “CSV 
Text File Format Rules for Catalogue” on page 6. Data loaded using a CSV text file 
must conform to your configured compliance checks and basic GTIN attribute 
validations and rules.

Step See this section
1. Create a basic MS Excel spreadsheet structure. “Create a Basic MS Excel Spreadsheet Structure” on page 10.
2. Apply a text format to attributes values that appear 
numeric, but must be shown as text.

“Apply MS Excel Formats to Attribute Values” on page 11.

3. Enter your data in the spreadsheet, one item per row. “Enter Data into the Spreadsheet” on page 12.
4. Save the spreadsheet as an MS Excel (.xlsx) file (to 
retain full data information).

“Save Your Spreadsheet as an MS Excel File” on page 12.

5. Save the spreadsheet as a CSV text file. “Save Your Spreadsheet as a CSV Text File” on page 12.
6. View the CSV text file in Notepad or a similar text 
editor.

“Viewing the CSV Text File in Notepad” on page 13.

 

Create a Basic MS Excel Spreadsheet Structure
1 Open MS Excel. 
2 From the File menu, select New.
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Creating a CSV Text File from an MS Excel Spreadsheet

3 Select Blank workbook. A blank worksheet displays.

4 Create a header row by typing attribute names into row 1 of the spreadsheet. 
The header row must contain the mandatory fields SELCODE, PRODUCT, 
ITEM_NUMBER, and ITEM_NUMBER_TYPE. 
For a complete list of attribute names, please refer to the OpenText Active 
Catalogue Attributes Guide.

Apply MS Excel Formats to Attribute Values 
Apply a text format to the columns of attributes that appear numeric but must be 
shown as text. 
MS Excel interprets the values in the columns; if they appear to be numeric, it 
removes leading zeros and may display the value in exponential format. This will 
cause problems in the CSV text file because all of the characters are important in 
attributes such as Selection Codes, Products, and GTINs. To prevent numbers from 
being truncated, these cells must be formatted as text.
1 On the spreadsheet you created above, select the following columns: 

SELCODE, PRODUCT, and ITEM_NUMBER (use Ctrl-click to select multiple 
columns).

2 Right-click on a cell and select Format Cells.
3 Click the Number tab and select Text from the Category list.
4 Click OK. 

The text format is applied to the selected columns.
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Enter Data into the Spreadsheet
Enter your data into the spreadsheet using one row for each item. Enter the value 
for each attribute below the corresponding attribute name in the header row.

Save Your Spreadsheet as an MS Excel File
Save the spreadsheet as an MS Excel (.xlsx extension) file. 
1 From the File menu, select Save As. 

The Save As window opens.
2 Navigate to the location where you want to save the file. 
3 In the File name box, type the name of your file using a .xlsx extension. 
4 In the Save as type box, select the file type Microsoft Office Excel 

Workbook (*.xlsx) from the drop-down list. 
Note: It is critical to save the data using a .xlsx spreadsheet format before 
you save the file as a CSV text file (.csv extension). If you do not do this, the 
CSV text file may lose critical information.

5 Click Save. 
The MS Excel file is saved.

Save Your Spreadsheet as a CSV Text File
Save the spreadsheet as a CSV text file. This is the file that will be uploaded to 
OpenText Active Catalogue.
1 From the File menu, select Save As. 

The Save As window opens.
2 In the File name box, type the name of your file using a .csv extension. 
3 In the Save as type box, select the file type CSV (Comma 

delimited)(*.csv) from the drop-down list.
4 Click Save. 

MS Excel displays a warning dialog box as it saves the spreadsheet data into 
the more restrictive comma separated format:
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5 Click OK. 
Another warning dialog box displays:

6 Click Yes. 
The CSV text file is saved.

Viewing the CSV Text File in Notepad
You can view the CSV text file in Notepad or a similar application.
1 To open the CSV text file in Notepad, right-click on the file and select Open 

With Notepad.

This file can be uploaded into OpenText Active Catalogue by selecting 
Data Management > Text File Upload. See “Using a CSV Text File to Upload 
Data” on page 13.

Using a CSV Text File to Upload Data
To use a CSV text file to upload data
1 Click Data Management > Text File Upload. 

The Text File Upload page opens.

2 Select one of the following types for the data you want to upload:
■ Item—select to upload item attributes
■ Image—select to upload product or item image attributes
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3 Click Browse. 
The Choose file dialog box opens. 

4 Navigate to the CSV text file you want to upload, select it, and click Open. 
The path to the file displays in the Upload File box.

5 From the Date Format drop-down list, select the date format used in the text 
file you are uploading. 

6 Click Process to upload the file. 
A message indicates that the file is processing. When the upload is complete, 
the Text File Upload—Results page displays the results of the upload. 
Every record is treated individually. If a file has 100 records, and there are 5 
errors, then 95 records were successfully processed.
For records that were not uploaded successfully, the errors in the text file are 
displayed. See the section, “Correcting Errors in the CSV File” on page 15 for 
details about how to correct the errors and resubmit the file. 

The header displays:
■ File Name—the name of the file 
■ File Size—the size of the file
■ Date Format—the date format used in the file:

■ 1=MM/DD/YYYY
■ 2=DD/MM/YYYY
■ 3=YYYY-MM-DD

■ Total Lines—the total number of lines in the file that can potentially be 
processed (does not include the header or any commented lines).

■ Lines Processed—the total number of lines that were actually processed. 
A subset of Total Lines since some lines may not have met validation 
requirements (for example, mandatory elements are missing). These errors 
are considered validation errors, and the lines are not processed. Each line 
is validated prior to processing it. 

■ Error Lines—the number of lines that generated an error during 
processing. Validation errors are not included.

■ Success Lines—the number of lines that were successfully processed.
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7 To upload another file, click Data Management > Text File Upload to return 
to the Text File Upload page where you can browse for and upload additional 
files.

Correcting Errors in the CSV File
Note: If the text file you uploaded contained errors, they display on the Text File 
Upload—Results page as soon as processing is complete. If you navigate away 
from this page, you will no longer be able to see the errors.Items that upload 
successfully can be downloaded using the Download process. See “Downloading 
Data” on page 208.

The table displays the line number of the error in your text file, the item number, 
the item type, the error code, and an error message. Correct the errors in your text 
file before uploading the file again.

To correct an error
1 In your CSV text file, locate the line number that corresponds to the line 

number of the error displayed on the Text File Upload—Results page.
2 Use the error message to determine what the error is.
3 Correct the error. For information about preparing and formatting a CSV text file 

for upload, see “CSV Text File Format Rules for Catalogue” on page 6.
4 Save the CSV text file and upload it again using the procedure, “Using a CSV 

Text File to Upload Data” on page 13.
If the text file was partially loaded, you should create a new file containing only the 
lines in error. This prevents Catalogue from generating additional errors and 
updating (and therefore, charging for) items that have already been successfully 
changed.
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Opening a Downloaded 
CSV Text File in MS Excel 3

This chapter describes how to work with a downloaded OpenText Active Catalogue 
text file within Microsoft Excel (MS Excel). The procedures step you through the 
process of opening the text file in MS Excel so that the format of the GTINs, 
Selection codes, and Products is preserved. 
Note: Catalogue creates a comma separated values (CSV) text file that has a .txt 
extension rather than a .csv extension. This allows you to open the text file in MS 
Excel and then set specific options so that the format of your data is preserved.
There are two methods for opening a text file in MS Excel:
■ Using the MS Excel Text Import Wizard—see “Using the MS Excel Text Import 

Wizard” on page 16
■ Using the Open With option from Windows Explorer—see “Using the Open With 

Option from Windows Explorer” on page 19

Using the MS Excel Text Import Wizard
1 Open MS Excel.
2 From the File menu, select Open. 

The Open window opens.
3 Navigate to the location of the text file (.txt extension).

Note: Next to the File name text box, be sure to select Text Files from the 
drop-down list so that all text files display. 

4 Select the file, and click Open. 
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MS Excel’s Text Import Wizard - Step 1 of 3 window opens.

5 Select Delimited as the file type that best describes your data (how your data 
will be read).

6 Click Next. 
The Text Import Wizard - Step 2 of 3 window opens.

7 Be sure that the following options are set:
a Under Delimiters, select the Tab check box and the Comma check box. 

Make sure that all other check boxes are cleared.
b Clear the Treat consecutive delimiters as one check box.
c From the Text qualifier drop-down list, select the double quotes (").

8 Click Next. 



O P E N I N G  A  D O W N L O A DE D  C S V  T E X T  F I L E  I N  M S  E X C E L

OpenText Active Catalogue Text File Reference Guide  18

3

The Text Import Wizard - Step 3 of 3 window opens

9 Select the first column (which contains the ITEM_NUMBER) by clicking the 
General column heading. 
The column highlights.

10 Under Column data format, select Text. 
The column heading now reads Text.
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11 Repeat Steps 9 and 10 for the third and fourth General columns (which contain 
the Selection Code and Product data) to set them to a Text data format.

Note: Depending on the filter you selected, Private Account IDs associated 
with Unit Cost and MSRP also need to be set to a Text data format.

12 Click Finish. 
The downloaded data displays in Excel, and the format of the GTINs, Selection 
codes, and Products is preserved. 

Note: To expand all columns to the width of the data within each column, 
highlight the entire spreadsheet by clicking on the upper left-hand corner of the 
spreadsheet, and then double-click on the line between any of the column 
headings.

Using the Open With Option from Windows Explorer
1 In Windows Explorer, navigate to the location of the text file.
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2 Right-click on the file and select Open With > Microsoft Office Excel.
Note: Double-clicking on the file will open it in Notepad.

The downloaded data displays in Excel, but each line of data is stored in the 
first column.

3 Select the first column (A) by clicking on the A column heading.
4 From the Data menu, select Text to Columns. MS Excel’s Text Import Wizard 

- Step 1 of 3 window opens. 
Continue with Step 5 in the section, “Using the MS Excel Text Import Wizard” on 
page 16, and complete the remaining steps in that section. They will guide you through 
Excel’s Text Import Wizard until the downloaded data displays in Excel.
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